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GETTING STARTED WITH 
 
 
 

CHILDREN’S CALENDAR / TIMELINES 

 

 

SuperFox has a handy calendar for presenting children’s attendances, which shows you graphically 
when children are booked into the setting. There are two versions. They both work the same way. We 
will look at the Family Accounts > Booking Centre version here. 

 
For one family at a time:  Home > Family Details > Family Centre > Calendar tab > 

For all children at the setting: Home > Family Accounts > Booking Centre > Calendar tab > 

 
You can also cancel bookings from the children and services calendars. See the Cancellations, Credits 
& Refunds mini guide for details. The Booking Centre calendar can also display setting capacity 
information. (See the Room Planning Mini Guide for details.) 

 

Children’s Calendar 

 

When you first select these options the children’s calendar will usually open showing a year-to-a-view: 

 

 

 

Tip:  Maximize! The calendar display is quite large and if you are using a 
1024 x 768 resolution monitor you will need to make your on work area as big 
as possible. Click on the maximise button (the middle control on the picture below). 
It may make your screen bigger. If not, don’t worry, it’s already as big as it will go. 
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If you would like to follow the following examples load Tutorial Dataset 3: 

Home > Backups & Tutorial Data > Tutorial Manager > 

  Double click on Tutorial Dataset 3 and check that the window title has changed.  

 

The calendar has five views. 
 
  The first view shows children’s bookings. 
  The second shows the services in use. 
  The third shows the children’s Free Entitlement hours. 
  The fourth view is the Quick Booking calendar. 
  The fifth shows setting capacity information. 

 

We will start with the Children view. 

 

Use the navigation buttons to move the calendar to September 2009 as 
shown on the previous page. 

    

      Double arrows make big jumps. 

     

   Single arrows make small jumps. 

 

Move between the year, month and week views. + shows more days, - shows fewer days                            

 

Now click the Toggle Sidebar option to show the calendar sidebar for the Children view. 

(If the calendar is now too small use the Toggle Workflow button to hide the Workflow Manager and free up 
some screen space.) 

             

 

 

Use the sidebar to look at the attendances of the individual child, Fiona Fish: 
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The day colours on this calendar are: 
 

 Green – Fiona is using the setting, or has a financial charge on the day. 

 White – The setting is open and there is nothing for Fiona. 

 Dark Grey – Not the current month 

 Light Grey – The current month and the setting is closed. 

 

The display options at the top of the sidebar determine what is shown on the calendar: 
 

 Financial – charges not affecting occupancy (e.g. Sun Hat on 24-Sep-2009) 

 Services – children attend the setting (e.g. 15:00->16:30 on 24-Sep-2009) 

 Birthdays – the day is outlined in red on a child’s birthday 

 

Use the button twice to change to Week view, ( ‘-‘ means show me fewer days): 

Each time use the navigation buttons to move the calendar to show the week beginning 14
th
 September 

2009. Choose the individual child James Leopard as shown below. 

 

 

 

On Tuesday 15
th
 September you can see that James is attending the setting for Free Entitlement from 

9am to 2pm and Afternoon Hourly from 2pm to 3pm.  

 

If you have the Birthdays box 
at the top of the calendar 
ticked you will see that it is 
also James’ 4

th
 Birthday. 
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All views of the children’s calendar have a handy menu that you can access by right clicking on a day 

 

This menu can jump to the Timeline or the 
day’s Timesheet / Register form, it can print 
the day’s register pages or the children’s ages 
and birthday reports. 

 
You can also print the current view of the 
calendar from the drop down menu. 

 

TIP: If you print a Weekly View calendar the 
printer can fit more items in each daily cell if 
you use you printer options to print in portrait 
format, rather than the usual landscape format. 

 
 

Children’s Timeline 

 
You can access the Children’s Timeline for any day on the Children’s Calendar by using the right-click 
menu for the day as shown above. 

The Timeline looks like this: 
 
Double arrows move one week, single arrows move one day at a time. 
 
    The Sort control allows you to very usefully order the timelines by: 

 Children’s first or last names 

 Children’s ages 

 Service used     

 Start or End times 

You can print a whole day on a single sheet of paper 
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The children have their ages displayed in brackets and they each have one or more coloured timelines 
(the number of timelines depends on the sort order you have chosen). The colours correspond to the 
children’s Ofsted age bands: 

 Blue – children aged under 2 years 

 Yellow – children aged 2 years 

 Purple – children aged 3 – 7 years 

 Green – children aged 8 and over 
 

 

 

  
 

The booked service names are written on the timelines and you can read the exact booking information 
by hovering with the mouse over the timeline. 

The five rows at the bottom of the timeline display show the numbers of children attending the setting in 
total and in each of the Ofsted age bands: 

 

 

 

The ability to sort the timelines gives a very clear picture of the setting usage through the day and allows 
you to quickly identify suitable times of day to revise your room plans. 

  

You can see that background of the timeline display is shaded blue between 8 am and 4 pm.  



 

  
 Software for Childcare Superheroes.  © Helios Computing Ltd. 6 

You probably noticed that the timeline has a button to display 
and hide a sidebar. 

 

This sidebar is used to change the time scale and  
to set the start and end time used for the timeline. 

 

The View Style options are: 

 Full Size   -   the usual time scale. 

 Best Fit   -   shrunk with minimal text loss 

 Entire Width   -   the full day in a single view 
 

 

 

 
Tip! You might wish to hide the workflow manager 
whilst using the timelines to give you more useful 
space on the screen. 

 
To hide the Workflow Manager simply un-tick the 
Workflow Manager option from the View menu at 
the top of the window, and tick it again when you 
wish to restore it to view. 

 

 

When you have finished exploring the timeline, return to the Calendar tab.  

 

 

Services Calendar 

 

This drop down option for the calendar shows the services in use on a given day.  

It’s a great way to see your planned activities and to check that the Quick Bookings went were you think 
they did. 
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The calendar has Year, Month and Week Views. The Year and Month views simply show that a service 
is in use on a given day using blue shading. The weekly view lists the services being provided on the 
day. 

 

This is the Weekly View for 
Monday 1

st
 March 2010. 

If you see this it means that there 
are more services than space 
available to display their names. 
Remember that you can always 
see them on the day’s Timeline. 

 

 

 

The Services Calendar also has a right click menu that 
you can use to change the view and to jump to the 
Timeline and the Timesheet / Register for the day. 

 

You can print the current view of the calendar from the 
drop down menu. 

 

TIP: If you print a Weekly View calendar the printer can 
fit more items in each daily cell if you use your printer 
options to print in portrait format, rather than the usual 
landscape format. 

 

Free Entitlement Calendar 

 

This drop down option shows the Free Entitlement in use on a given day. It is an instant view that will 
help ensure that daily and weekly limits are not accidentally exceeded. The Calendars also have a 
children’s birthday overlay that can be helpful for confirming eligibility. 

This calendar has a Year View and a Month View, the month view shows the Free Entitlement hours in 
use on a given day, for an individual child. You can also show their birthday. 
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You could also show the Free Entitlement use for all children in the setting for each day of the month. 

 

 

 

 

Free Entitlement Check 

 

You can produce two reports about the 
Free Entitlement use from the Free 
Entitlement view by pressing the ‘Free 
Entitlement Check button’ on the 
second sidebar tab. 
 

 

 

The form shown here will pop-up. 

You will need to specify a date range to 
use for the report. 

 
The Summary only report will use the 
exact date range that you specify. The 
Weekly Totals report will use a date 
range that has complete weeks that 
include both your start date and end 
date. 

You can optionally report on all 
children, an individual child, a group or 
a class. 
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There are two report styles that you can choose: 

 

Weekly Totals 

This report will report on the funded hours used for each child and the number of days on which they 
were used for complete weeks encompassing the start and end dates.  

This is a useful report for checking the correct weekly usage. 

 

Summary Only 

This report provides an exact total of the funded hours used between the start and end dates.  

This report is useful for checking annual allowances. 

 

If you would like to try it yourself you can produce the following two examples using Tutorial Dataset 3 
and the settings shown in the picture above. 

Home > Backups & Tutorial Data > Tutorial Manager > 

  Double click on Tutorial Dataset 3 and check that the window title has changed.  

 

Here is an example of the Weekly Totals report for 07 September 2009 to 20 December 2009. 
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Each child’s weekly funded hours and days on which they were used are listed and totalled for the 
period specified. It is easy to check if the bookings will exceed daily limits. 

 

 

 

The report ends with a grand total of the funded hours used by the children specified in this period. 

 

Here is an example of the Summary Only report for 07 September 2009 to 20 December 2009. 

 

 

 

 

These reports can be printed or saved in a variety of formats including PDF. You can find more details 
about saving reports in the Using Reports mini guide. 
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Immediately below the Free Entitlement Check button you will 
find three more buttons. 

 

You can use these buttons to produce the printed Free 
Entitlement Headcount and Usage reports and the Early 
Years Census return. These reports can also be found in: 
 

Home > Management Reports > Early Years Reports > 

These reports are described in detail in the Headcount 
Returns mini guide. 

 

 

 

The Free Entitlement Calendar also 
has a right click menu that you can 
use to change the view and to jump to 
the Timeline and the Timesheet / 
Register for the day. 

 

You can also print the current view of 
the calendar from the drop down 
menu. 

 

 

 

 

Cancellations 

 

You can select and cancel bookings using the calendar Children and Services views. 
 

Cancellations applied in the Children view are good for cancelling one or all children in the setting or 
family depending on whether you are using the Booking Centre or Family Centre calendar. Snow days 
are best cancelled from the Booking Centre Children calendar. 
 

Cancellations made in the Services view are good for cancelled services, for example your gymnastics 
coach may have cancelled due to a broken leg. 

 

This function is described in detail in the Cancellations, Credits and Refunds Mini Guide. 

 

 
Quick Bookings and Undo Quick Bookings 

 

The next calendar view is the Quick Bookings calendar, which is the main booking entry method for the 
program. This is described in detail in the Quick Bookings mini guide along with the ‘Undo Quick 
Bookings’ function. 
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Capacity Planning Calendar 

 

 

If you need to book in a child and would like to check the capacity remaining in the setting you can 
always set up and validate a quick booking without pressing the ‘Apply Quick Booking’ button. 

This will work well whether or not you have planned the days concerned. 

 

Alternatively you can use the Booking Centre calendar to select some days and check the capacity. 

Booking Centre > Calendar tab > Capacity Planning option > 

 

The capacity planning calendar looks like this: 

 

 

 

 

The calendar is simple to use: 
 

   Select the days that you would like to check the capacity. (Days with a room plan are initially 
displayed in blue.) 

   Use the right click menu to choose a check to apply. 

 

There are three checks that you can use for the days that you have selected, and these are also 
available from buttons on the calendar sidebar: 

 
 

1. Check capacity to see if you can fit in some extra children. 

2. Check to see if the existing bookings fit the planned days. 

3. Check to see if the plans used contain errors.  

 

 
The Clear Date Selection button will clear your date selection from the calendar so you can start again. 
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Check Capacity on Selected Days 

 

(Check Capacity on Selection button on the sidebar.) 

 
This is the most detailed capacity check. It can check to see if extra children can be booked into the 
setting. There are two parts to the check: 

 

1.  Will the extra children fit within the existing room plan? 
 

2.  Will the extra children fit in the setting regardless of the planned numbers? 

 

To make the check select the days of interest on the Capacity Planning calendar and either use the 
sidebar buttons or the right click menu to choose Check Capacity on Selection. A small form will pop up 
that looks like this... 

 

 

Now enter the numbers of children that you are 
interested in booking in the appropriate age bands. 

 

 

If you have room planned the days then specify a 
class for the extra children to join on the selected 
days. 

(If you don’t choose a class the program will see if 
there is room for the extra children across all of the 
planned rooms.) 

 

Now specify the start and end times that you want to 
use for their bookings. 

 

 

If you want to see if the children can be 
accommodated regardless of the planned numbers 
tick the ‘Full Calculation’ box. 

 

 

The first check will add the booked children to the extra child numbers and look for: 
 

 Numbers greater than planned in each age band, if there is a plan. 

 Setting registration limits being exceeded. 

 

If you choose to apply the Full Calculation check the program will disregard the planned numbers of 
children but will use the planned number of staff to see if the extra children could fit into the selected 
class. (Or all classes if no class was selected.)  

 
When you press OK the program will check the capacity on the selected days. 
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If the check finds any issues they will be displayed in another pop-up list that you can print or save as a 
PDF document.  

 

Here we tried to book in an extra 100 under 2’s... 

 

 

 

 

 

 

After you have made the days that you selected on 
the calendar will be coloured yellow if they have 
warnings: 

 

 

 

 

 

 

A green triangle on a day with warnings indicates that 
the room plan could not accommodate the extra 
children, but they would probably fit into the setting 
anyway. 
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Compare Bookings to Plan on Selected Days 

 

(Check Bookings to Plan button on the sidebar.) 

 

This is a simpler test which just compares the number of children already booked into the setting to the 
numbers planned for the day. 
 

 For planned days the check compares bookings to the planned child numbers and the setting 
registration limits. 

 For unplanned days the check compares bookings to the setting registration limits only. 

 

 

 

Validate Plan on Selected Days 

 

(Validate Plan on Selection button on the sidebar.) 

 

This is the simplest check which just looks at the room plans applied to any of the selected days and to 
check for errors in the plan. 

 

 

 

IMPORTANT - CHECK THE RESULTS 

 
We do not guarantee that the results of these capacity planning calculations. You should check that the 
results are acceptable in your setting before use. 

 

 

Other Mini Guides 

 

You can read more about room planning and classes in the following mini guides: 

 Room Planning 

 Child Groups & Classes 

 

 

 

 

 

 

 

 

 

End 


